LENESANS Release Note

RZ/T2H Group
ENCOUT sample program

Summary
This document describes the RZ/T2H encoder divided-output (ENCOUT) module sample program package.

Functionality Checked Device
RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)
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RZ/T2H Group ENCOUT sample program

1. Package Contents

This package contains the following contents.
The RZ/T2H has one unit of ENCOUT module. The number of output channels supported by this sample

program is one.

1.1 Software
e Source code

No. Name Version number
1 RZ/T2H ENCOUT sample program (CR52 ver.*) 20
2 RZ/T2H ENCOUT sample program (CA55 ver.*) 2.0

Note This sample program has a CR52 version that runs on the CPU core Cortex-R52 and a CA55 version
that runs on the CPU core Cortex-A55. CR52 ver. and CA55 ver. are descriptions of the respective
version.

1.2 Documents

No. Document name Version File name
1 RZ/T2H Group ENCOUT 2.01 () r11an0817jj0201-rzt2h.pdf
sample program Release Note (e) r11an0817ej0201-rzt2h.pdf (this document)
2 RZ/T2H Group ENCOUT 2.00 (j) r11an0816jj0200-rzt2h-encout.pdf
sample program Application (e) r11an0816€j0200-rzt2h-encout.pdf
Note
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ENCOUT sample program

2. File Structure

The file structure and contents of this package are detailed below.

Top
— r11an0817j0201-rzt2h.pdf
F— r11an0817ej0201-rzt2h.pdf
L— workspace
— Software
| —iccarm
| | — RZ_T2H_CR52_encout.zip
I .
\ \ L— RZ_T2H_CA55_encout.zip
| | — RZ_T2H_CA55_0_encout
| |
| | L—RZ_T2H_CR52_0_primary
| —gcc
| — RZ_T2H_CR52_encout.zip
| |
| L— RZ_T2H_CA55_encout.zip
| —RZ_T2H_CA55_0_encout
| |
| L— RZ_T2H_CR52_0_primary
L— Documents
— r11an0816jj0200-rzt2h-encout.pdf
L— r11an0816ej0200-rzt2h-encout.pdf

: RZ/T2H ENCOUT sample program set

CR52 ver. (IAR)

: RZ/T2H ENCOUT sample program set

CAS55 ver. (IAR)

: CPU CTRL register setting program (IAR)

: RZ/T2H ENCOUT sample program set

CR52 ver. (e? studio)

: RZ/T2H ENCOUT sample program set

CAS55 ver. (e? studio)

: CPU_CTRL register setting program (e? studio)

R11ANO0817EJ0201 Rev.2.01
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RZ/T2H Group ENCOUT sample program

The file structure of the RZ_T2H_CR52_encout.zip and the RZ_T2H_CA55_0_encout folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Build Tool Dependent Environment Files )
L—src
— hal_entry.c : ENCOUT sample program
F— encout_main.c : ENCOUT sample program
— siochar.c : SCI_UART sample program
— siorw.c : SCI_UART sample program
— sio_char.h : SCI_UART sample program
F— sci_uart
F—elc
| F—r _ elc.c : ELC driver file
| F—r_elc.h : ELC driver file
| F—r_elc_api.h : ELC driver file
| L—r _elc_cfg.h : ELC driver file
L—drv
F— src
| L—r_encout_rzt2.c : ENCOUT driver file
L—inc
— iodefine_encout.h : ENCOUT register definition file
—r_encout_rzt2_config.h : ENCOUT driver file
L—r_encout_rzt2_if.h : ENCOUT driver file

The file structure of the RZ_T2H_CR52_0_primary folder is shown below.

Top folder
— configuration.xml : FSP Configuration data
— ( Build Tool Dependent Environment Files )
L—src
L— hal_entry.c : CA55 start-up program

R11AN0817EJ0201 Rev.2.01
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3. About ENCOUT Sample Program

This section contains information necessary to use the complete set of ENCOUT sample program.

3.1 Software Information
3.1.1 Base OS

This sample program is OS-independent.

3.1.2 Memory Size

Memory size used by this sample program and ENCOUT driver is shown in following table. This table does
not include memory size used by Flexible Software Package or C language libraries of the compiler.

(1) CR52 ver.

ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
ENCOUT driver Code 0.7 0.7
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.0 0.0
Sample program Code 0.7 1.1
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.2 0.2

(2) CADb55 ver.
ltems Memory Size

EWARM e? studio

[kBytes] [kBytes]
ENCOUT driver Code 1.3 1.1
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.1 0.0
Sample program Code 1.2 2.0
Data (with initial value) 0.0 0.0
Data (without initial value) 0.0 0.0
Constant Data 0.2 0.2
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RZ/T2H Group ENCOUT sample program

3.2 Hardware Information
3.2.1 Device
RZ/T2H

3.2.2 Target Board
(1) Board Name

RZ/T2H Evaluation Board (RTKORZT2HXXXXXXXXX)

(2) Setting of the Target Board
Target board configuration is as follows.
SW14-1: ON, SW14-2: OFF, SW14-3: ON, SW14-6: OFF (Set xSPI1 boot mode)

(3) Used Pins for the Target Board

The correspondence between the pin used by the ENCOUT and the pin header of the target board is as
follows. Only channel 0 is available.

Channel Pin name Pin header Input/Output Voltage domain Description

Channel 0 | POUTA CN24 #27 output VDD33 Phase A output pin

POUTB CN24 #28 output VDD33 Phase B output pin

POUTZ CN24 #29 output VDD33 Phase Z output pin
R11AN0817EJ0201 Rev.2.01 Page 6 of 17
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3.3 Procedures on Development Environments: CR52 ver.

3.3.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select higher-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.3.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM (EWARM)

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CR52_encout.zip and copy the extracted source files to the desired location.
2 Activate EWARM.

3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_encout.eww.

5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.

You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.
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RZ/T2H Group ENCOUT sample program

6 Inthe FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,
rzt_cfg, rzt_gen, script and .setting folders will be generated.

IE C:¥1_Prog¥Work¥Work_C¥Work_EWA_960_2_fsp2.2.0¥RZT2H_ENCOUT release_chk - FSP Smart Configurator — O . ‘

File Window Run Help

¢ [RZT2H_ENCOUT release_chk] FSP Configuration ey “% FSP Visualization

| =} = g »

Summary Generate Project Content

Project Summary Al [Goooss-oeee: -~ os e e
RENESAS T g 88- 3-~—8 e

Board: RZT2H Evaluation Board (RAM execution without flash memory) 1 58888885 -

Device: ROADSGO7TMA4GBG R A g _

Core: CR52 CPUO

FSP Version: 220 E-1-94-0-4-4-0-3-4-4-0-3-4-3-4-4-$- PSS

Project Type: Flat €6 Ené 4

Location: C:/1_Prog/Work/Work_C/Work_EWA_960_2_fsp2.2.0/RZT2H_ENCOUT _release_chk =<~

Selected software s} its

Board support package for ROA09G077M44GBG v220
Board support package for RZT2H v220 a8 4

Board support package for RZT2H - FSP Data v220 2 - 5909099000

....... 2080889 FOPERDS

T e YT Y Y

o G- HIH-0SES - FEIDEEDDS
X -- o B8e- & LTS
MY $500. 96 FEBOOSPDS

Support [k ° e 800-- 03 S ES00E00

Summary | BSP| Clocks | F

™ E&=0 B comsole =X =00

No consoles to display at this time.

[ Properties (%] Problems

7 When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\RZ_T2H_encout.out is generated.

(4) Sample Program Execution Procedure

After executing the "build procedure”, connect the target board and debugger correctly, and perform the
following operations.

1 Select [Project] menu -> [Download and Debug].
2 Select [Debug] menu -> [Execute].

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample program.
Additionally, Phase ABZ signals shown in the RZ/T2H Group ENCOUT Sample Program Application Note
“4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown in “3.2.2(3) Used
Pins for the Target Board”.

3.3.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version: GNU ARM Embedded 12.2.1.arm-12-24
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98c
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(3) Build Procedure of the Sample Program

The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CR52_encout.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

5 Double-click the configuration.xml in the Project Explorer pane of e? studio to open it.

a RZT2H_ENCOUT_release_chk - & studio — O *® ‘
File Edit Source Refactor Mavigate Search Project RenesasViews Run Renesas Al Window Help
A e e Q~ Q 58| B
{3 Project Explorer X =i = 0 || Outline X = B
SR d There is no active editor that | &8

v £S5 RZ_T2H encout| provides an outline.

nit Includes

12 configurationxml

iZ_I2H_encout Debug_Flatjlink
X| RZ_T2H_encout Debug_Flatlaunc

7) Developer Assistance

*| problems x | B Console| [T Properties @ Smart Browser L} Smart Manual s =
0 errors, 12 wamnings, 0 others
Description Resource Path Location Type
L Warnings (12 items)
¢ >
0 items selected
6 Click Generate Project Content in the FSP Configuration pane of e? studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated.
{8 RZT2H_ENCOUT release_chk - RZ_T2H_encout/configurationxml - & studio - o X
File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help
H-&~ v ifpr Q- Q H | o
gy Project Explorer X = 0O ||{ [RZ_T2H_encout] FSP Configuration X == Outline X R=0|s
= ' Summar (*] [rhere is no active editor that @
v |5 RZ_T2H_encout y Generate Project Content rovides an outline.
B Includes Project §
5 roject Summal A
& src ) y RENESAS
1 configurationxm! i
RZ_T2H_encout Debug_Flatjlink Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROAD9GO7TM44GBG
%] RZ_T2H_encout Debug_Flatlaunch
) Developer Assistance Cose: CRe2 CP0
Toolchain: GCC for Renesas RZ
Toolchain Version: 122 1 arm-12-24
FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_E2S_RZ..._ENCOUT_release_chk/RZ_T2H_encout ==
Selected software components
Board support package for ROA09G077M44GBG V220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data V220 v
jON 4
Support ik =
Summary BSP. Clocks | Pins | Interrupts | Event Links | Stacks Components
*) Problems x | B Console [7] Properties @ Smart Browser| &) Smart Manual § =0
0 errors, 12 wamings, 0 others
Description Resource Path Location Type
b Warnings (12 items)
< >

7 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_encout.elf file is generated.

R11AN0817EJ0201 Rev.2.01
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RZ/T2H Group ENCOUT sample program

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging].
2 Click [Debug] to start downloading to internal RAM.
3 Click [Run] menu -> [Resume] to run the sample program.

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample program.
Additionally, Phase ABZ signals shown in the RZ/T2H Group ENCOUT Sample Program Application Note
“4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown in “3.2.2(3) Used
Pins for the Target Board”.
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3.4 Procedures on Development Environments: CA55 ver.

3.4.1 Preparation before Executing the Sample Program

This sample program communicates with a PC. The USB connection terminal on the target board is CN34.
Select lower-numbered port from COM ports that appear at connecting the board with the host PC.

The terminal software of the host PC is set as shown in the following table.

Function Setting
Communication method Asynchronous serial transmission/reception
Order of transmission / reception LSB first
Transfer rate 19200 bps
Character length 8 bits
Stop bit length 1 bit
Parity function None
Hardware flow control None

3.4.2 EWARM from IAR Systems
(1) Build Environment

IAR Embedded Workbench for ARM

Version 9.60.2 + patch (EWARM_Patch_for RZT2H N2H_rev1.0)
RENESAS FSP Smart Configurator (FSP SC) 2024-10
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
IAR I-jet

(3) Build Procedure for Sample Programs
The build procedure for the sample program is as follows.

1 Extract RZ_T2H_CA55_encout.zip and copy the extracted source files to the desired location.
2 Activate EWARM.

3 Select [File] menu -> [Open Workspace].

4 Open the extracted source file RZ_T2H_CR52_0_primary -> RZ_T2H_CR52_0_primary.eww.
5 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE. *

Note: The following procedure adds the activation of the FSP Smart Configurator to the [Tools] menu of the
EWARM IDE. Select [Tools] menu -> [Tool Configuration] in the EWARM IDE. Select the [New]
button, specify a table string in each field, and press [OK].

Field String
Menu text FSP Smart Configurator
Command $RASC_EXE_PATHS
Argument --compiler IAR configuration.xml
Initial directory $PROJ_DIR$

String for the command is variable holding the path of the Smart Configurator execution file, rasc.exe.
You can also start the FSP Smart Configurator directly from the command prompt by specifying the
folder where it is installed.

R11AN0817EJ0201 Rev.2.01 Page 11 of 17
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6
rzt_cfg, rzt_gen, script and .setting folders will be generated.

G C#1_Prog¥Work¥Work C¥Work_EWA _960_2 fsp2.2.04RZT2H_ENCOUT CASS release_chk¥RZ_T2H_CRS2 0_primary - FSP Smart Configurator

FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96__ release_chk/RZ_T2H_CR52_0_primary |

Selected software components

Board support package for ROA0SGOTTM44GBG

V220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v2.2.0 o
ol (-
Support
Summary | BSP| Clocks | P Interrupts | Event Link > A5
[T Properties [2] Problems *§ =0 Bconsole ]

No consoles to display at this time.

Properties are not available

When project generation is complete, close the Smart Configurator.
8 Select [Rebuild ALL] from the [Project] menu of EWARM.

The file Debug\Exe\RZ_T2H_CR52_0_primary.sbd is generated.
9 Select [File] menu -> [Open Workspace].

- [m] X ‘

File Window Run Help

& [RZ_T2H_CR52_0_primary] FSP Configuration "> FSP Visualization =0

g O »

Summary Generate Project Content 5 £

Project Summary A

RENESAS

Board: RZT2H Evaluation Board (RAM execution without flash memory)

Device: ROA09GOTTM44GBG

Core: CR52 CPUO

In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

10 Open the extracted source file RZ_T2H_CA55_0_encout — RZ_T2H_CA55_0_encout.eww.
(RZ_T2H_CR52_0_primary.sbd of the primary project is referenced to open this workspace file.

Please build the primary project in advance.)
11 Start the FSP Smart Configurator from the [Tools] menu of the EWARM IDE.

12 In the FSP Configuration pane of the Smart Configurator, click Generate Project Content. The rzt,

rzt_cfg, rzt_gen, script and .setting folders will be generated.

E C¥1_Prog¥Work¥Work C¥Work EWA_960_2 fsp2.2.0¥RZT2H_ENCOUT CA55_release_chk¥RZ T2H_CAS5 0_encout - FSP Smart Configurator [m] X ‘
File Window Run Help
8} [RZ_T2H_CAS55_0_encout] FSP Configuration 5 FSP Visualization =0
Summary Generate Project Content 5 | =
Project Summary : A
RENESAS
Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROA09GOTTM44GBG
Core: CAS5 Core0
FSP Version: 220
Project Type: Flat
Location: C:/1_Prog/Work/Work_C/Work_EWA_96___release_chk/RZ_T2H_CA55_0_encout <=
Selected software components
Board support package for ROA0SGOTTM44GBG v220
Board support package for RZT2H v220
Board support package for RZT2H - FSP Data v220 ot
|98 4~
Support
nary| BSP| Clocks | 7 = » B
[ Properties [2] Problems 28 0| Bconsole Mo B
No consoles to display at this time.
Proj s are not available

13 When project generation is complete, close the Smart Configurator.
14 Select [Rebuild ALL] from the [Project] menu of EWARM.
The file Debug\Exe\ RZ_T2H_CAS55_0_encout.out is generated.
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(4) Sample Program Execution Procedure

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Inthe workspace of RZ_T2H_CR52_0_primary, select [Project] menu -> [Download and Debug].
RZ_T2H_CA55_0_encout project is launched.

2 Inthe workspace of RZ_T2H_CR52_0_primary, select [Debug] menu -> [Execute]. CA55 start-up
program is executed.

3 In the workspace of RZ_T2H_CA55 0_encout, select [Debug] menu -> [Execute]. Sample program is
executed.

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample program.
Additionally, Phase ABZ signals shown in the RZ/T2H Group ENCOUT Sample Program Application Note
“4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown in “3.2.2(3) Used
Pins for the Target Board”.

3.4.3 e? studio from RENESAS
(1) Build Environment

RENESAS e? studio 2024-10
Toolchain version:
GNU ARM Embedded 12.2.1.arm-12-24 (Used by RZ_T2H_CR52_0_primary)
GCC ARM A-Profile (Aarch64 bare-metal) 10.3.1.20210621 (Used by RZ_T2H_CA55_0_encout)
RENESAS Flexible Software Package (FSP) for RZ/T2 v2.2.0

(2) Execution Environment ICE
SEGGER J-Link v7.98¢c

(3) Build Procedure of the Sample Program
The procedure for building the sample program is as follows.

1 Extract RZ_T2H_CA55_ encout.zip and copy the extracted source files to the desired location.

2 After launching e? studio and moving to the workspace, click the [File] menu -> [Import] and select
Existing project to workspace and click [Next].

3 On the project import screen, select the folder where the sample program was expanded as the root
directory.

4 Select a project, check Copy Project to Workspace, and click [Finish].

R11AN0817EJ0201 Rev.2.01 Page 13 of 17
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5 Double-click the configuration.xml of the RZ_T2H_CR52_0_primary project in the Project Explorer
pane of e studio to open it.

& RZT2H_ENCOUT_CASS_release_chk - ¥ studio — Bl X ‘
File Edit Source Refactor Nawigate Search Project RenesasViews Run Renesas Al Window Help

b T witpv Q- Q || e
I¢5 Project Explorer % |E 8 7 § © O = 0|3 ouine x| = 0Olg
~ |5 RZ_T2H_CA55_0_encout (<)

w Includes There is no active editor

3 sre that provides an outline.

24 configurationxml
RZ_T2H_CAS55_0_encout Debug_Flatjlin
X| RZ_T2H_CA55_0_encout Debug Flatlau
7) Developer Assistance
v |5 RZ_T2H_CRS2_0_primary [Debug]
) Includes
ol

RZ_T2H_CR52_0_pnmary Debug_Flat,lit
X] RZ_T2H_CR52 0 primary Debug_Flatla

(7) Developer Assistance

|#. Problems x| [ Console| [ Properties| @& Smart Browser | L1} Smart Manual ] =
0 errors, 24 warnings, 0 others
Description Resource Path Location Type

b Warnings (24 items)

¢ configurationxmi - RZ_T2H_CR52_0_primary

6 Click Generate Project Content in the FSP Configuration pane of e?studio.
The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CR52_0_primary

project.
Q RZT2H_ENCOUT CASS release_chk - RZ_T2H_CR52_0_primary/cenfiguration.xml - e* studic - ] X ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help
R R oitpr Q- Q im| B+
Igy Project Explorer X | = 4 § = O ||{& [RZ_T2H_CR52_0_primary] FSP Configuration X b ™= Outline X =0
~ 25 RZ_T2H_CAS55_0_encout Thes %)
I RZ_T2H_CAS5 0. re is no active editor that | €a
Summar £ -
) Includes 24 Generate Project Content |l provides an outline.
(£
18 configurationmi Project Summary S A
RZ_T2H_CAS5_0_encout Debug_Flatijlink =
%) RZ_T2H_CAS5_0_encout Debug_Flatlaunc Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROAD9IGOTTM44GBG
%) Developer Assistance
v |5 RZ_T2H_CR52_0_primary [Debug Con: CR52 CPUO
RE Toolchain: GCC for Renesas RZ
5
ot Toolchain Version: 122 1 arm-12-24
@ s
2 P i FSP Version: 220
o configurationxm
B RZ T2gH CR52.0 Debug_Flatjlink Froject Type: e
rimary Debug_Flatjlini y
W P L Location: C:1_Prog/Work/'Work_C/Work_E2S_RZ...release_chk/RZ_T2H_CR52_0_primary <
%] RZ_T2H_CRS2_0_primary Debug_Flatlaun
7) Developer Assistance Selected software components
Board support package for ROA09GOTTM44GBG v2.20
Board support package for RZT2H v2.20
Board support package for RZT2H - FSP Data V220 o

QEO

Summary  BSP| Clocks Pins | Interrupts | Event Links Stacks| Components.

2! Problems X | B Console| [T] Properties | @ Smart Browser | L} Smart Manual

0 errors, 24 wamnings, 0 others

Description Resource Path Location Type
& Wamings (24 items)

< >

&} configurationxmi - RZ_T2H_CR52.0_primary

7 Select RZ_T2H_CR52_primary project in the Project Explorer pane and execute [Run] menu -> [Build
Project].
The file Debug\RZ_T2H_CR52_0_primary.sbd is generated.

8 Double-click the configuration.xml of the RZ_T2H_CA55_0_encout project in the Project Explorer
pane of e2 studio to open it.
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9 Click Generate Project Content in the FSP Configuration pane of e? studio.

The rzt, rzt_cfg, rzt_gen, script, .settings folders are generated in the RZ_T2H_CA55 0_encout
project.

a RZT2H_ENCOUT CASS release_chk - RZ_T2H_CAS5_0_encout/configuration.xml - e studio [m] X ‘
File Edit Source Refactor Navigate Search Project RenesasViews Run RenesasAl Window Help
B-& - o its - Q- Q | Eoces
(o Project Explorer X =R § = O ||{F [RZ_T2H_CR52_0_primary] FSP Configuration 454 [RZ_T2H_CA55 0 _encout] FSP C x =0 B Outline X = 0|
~ |5 RZ_T2H CAS5 0 encout Simmary 0 There is no active editor that €%
@ Includes Generate Project Content | provides an outline
@ sre )
£ configurationxmi Project Summary ) A
RENESAS
RZ_T2H_CAS5 0 encout Debug_Flatjlink ) )
%) RZ_T2H_CASS5_0_encout Debug Flatlaunc Board: RZT2H Evaluation Board (RAM execution without flash memory)
Device: ROAQ9GOTTM44GBG
?) Developer Assistance AASE Coral)
“ 5 RZ_T2H_CRS2.0_primary So G50 Cord
& Binaries Toolchain: GCC for Renesas RZ (A-Profile AArch64 bare-metal)
s Toolchain Version: 10.3.1.20210621
#) Includes
ot o FSP Version: 220
s Project Type: Flat
Bm y "
» Location: C:/1_Prog/Work/Work_C/MWork_E2S RZ _release_chk/RZ_T2H_CAS5_0_encout <=
@ s
@& Debug Selected software components.
5 rtcfg
& seript Board support package for ROA09GOTTM44GBG V220
& configurationxml Board support package for RZT2H v2.20
RZ_T2H_CR52_0_primary Debug_Flatjlink Board support package for RZT2H - FSP Data v220 o
%] RZ_T2H_CR52_0_primary Debug_Flatlaun e
) Developer Assistance @ "
Support i} ©
Summary | BSP| Clocks | Pins| Interrupts | Event Links | Stacks| Components
2. Problems B Console X | [T Properties| @ Smart Browser | K&} Smant Manual ® T xE *8-8~-=0
C€DT Build Console [RZ_T2H_CA55_0_encout]
< >

10 Select [Project] menu -> [Build All]
The Debug\RZ_T2H_CA55_0_encout.elf file is generated.

(4) Execution Procedure of the Sample Program

After executing the "build procedure", connect the target board and debugger correctly, and perform the
following operations.

1 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ_T2H_CR52_0_primary project.

Click [Debug] to start downloading to internal RAM.
2 Click [Run] menu -> [Resume] to run the CA55 start-up program.

3 Select [Run] menu -> [Debug As] -> [Renesas GDB Hardware Debugging] for the
RZ _T2H_CA55_0_encout project.

4 Select 'No' when 'A Renesas GDB debug session is already active' is displayed.
& Launcher X

I A Renesas GDB debug session is already active.

Do you want to terminate all currently active debug sessions before starting the new
session? (Note: Selecting No may result in unstable debug functionality)

[[] Remember my decision

Yes I Mo I Cancel

5 If 'Proceed with launch' is displayed, select 'Yes'.
6 Click [Debug] to start downloading to internal RAM.
7 Click [Run] menu -> [Resume] to run the sample program.
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RZ/T2H Group ENCOUT sample program

(5) Execution Result of the Sample Program

The ENCOUT driver version is displayed in the terminal software window by executing this sample program.
Additionally, Phase ABZ signals shown in the RZ/T2H Group ENCOUT Sample Program Application Note
“4.8.9 Execution Result of the Sample Program” are outputted to the pin headers shown in “3.2.2(3) Used
Pins for the Target Board”.
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Rev.

Date
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0.50
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0.70
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Updated the source code and the release note version
number.

Update file structure.

Added explanation of CA55 ver.

Updated memory size information.

Added explanation of CA55 ver.

Update build environment.

Update build and execution procedure.

Added explanation of CA55 ver.

2.00

Nov 21.24

Update revisions of the application note and the release note.
Update sample program version to 2.0. (Support FSP v2.2.0.)
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Update memory size information.

Add SW14 in setting of target board.

Update build environment for FSP v2.2.0. Figures are
replaced.

2.01

Dec 13.24

Update revision of the release note.
Correct path name of the FSP SC in the sample program
environment files to use default installation path.
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General Precautions in the Handling of Microprocessing Unit and Microcontroller
Unit Products

The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products.
1. Precaution against Electrostatic Discharge (ESD)
A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps
must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be
adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity.
Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and
measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices.
2. Processing at power-on

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of
register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset
pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins
in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the

level at which resetting is specified.
3. Input of signal during power-off state

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or /0
pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal

elements. Follow the guideline for input signal during power-off state as described in your product documentation.
4. Handling of unused pins

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are
generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of
the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal

become possible.
5. Clock signals

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program
execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator
during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable.
6. Voltage application waveform at input pin

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between V.
(Max.) and Vi1 (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the

input level is fixed, and also in the transition period when the input level passes through the area between Vi (Max.) and Vix (Min.).
7. Prohibition of access to reserved addresses

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these

addresses as the correct operation of the LSl is not guaranteed.
8. Differences between products

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems.
The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms
of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values,
operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product.



Notice

1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products
and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of
your product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the
use of these circuits, software, or information.

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights,
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples.

3. Nolicense, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics
or others.

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export,
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required.

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering.
6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for

each Renesas Electronics product depends on the product’s quality grade, as indicated below.

"Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc.
"High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key
financial terminal systems; safety control equipment; etc.

Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas
Electronics disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas
Electronics product that is inconsistent with any Renesas Electronics data sheet, user’'s manual or other Renesas Electronics document.

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE,
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE.

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user's manuals, application notes, “General Notes for

Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by

Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc.

Renesas Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products

outside of such specified ranges.

Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific

characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability

product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you
are responsible for evaluating the safety of the final products or systems manufactured by you.

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance
with applicable laws and regulations.

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions.

12. ltis the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document.

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics.

14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas
Electronics products.

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled
subsidiaries.
(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.

Corporate Headquarters
TOYOSU FORESIA, 3-2-24 Toyosu,
Koto-ku, Tokyo 135-0061, Japan

www.renesas.com

Trademarks

Renesas and the Renesas logo are trademarks of Renesas Electronics
Corporation. All trademarks and registered trademarks are the property
of their respective owners.

(Rev.5.0-1 October 2020)

Contact information

For further information on a product, technology, the most up-to-date
version of a document, or your nearest sales office, please visit:
www.renesas.com/contact/.
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